LISTmap Case Study
Background: 
I am looking to purchase a property which is located in the Municipality of Meander Valley near the township of Deloraine.  

[bookmark: _GoBack]Before I make the purchase, I want to get an idea of the properties that surround the parcel of land I am interested in purchasing, its topographic features, and what enterprise suitability crops can potentially be grown.

LISTmap is an online map viewer that allows me to find this type of information using a wide range of authoritative land-based information. 
Start of Exercise:
ADDING LAYERS TO LISTMAP (REFER TO LIVE DEMO FOR STEPS 1 to 6)
1. Open up a web browser (Internet explorer, Chrome, Safari or Fire fox) and type in the following URL (www.thelist.tas.gov.au) – press enter.
2. The LIST web site appears with a number of key services available.
[image: A screenshot of a computer

Description automatically generated with medium confidence]



3. Select the LISTmap key service with a left mouse button. (LISTMap pictured below)
[image: ]
4. In the search area (identified below) enter either of the known key identifiers of the parcel - Title reference 52933/1 or PID 7778595 and hit the ‘Enter” key.  LISTmap will zoom to the parcel of interest.
[image: ]Search text box





Result:
[image: ]
5. Now using the “Layers” tab (pictured below) add in the necessary layers that will allow us to gain an understanding of the land.  Layers to be added include:
a. Enterprise Suitability Crops – Potatoes
b. Contours (10 metres)
c. Cadastral Parcels
To add map layers to LISTmap, refer to the following steps:
Step A – Select the layers tab with a left mouse button.
[image: ]“Layers” tab



Step B - Now select the “Add Layer +” banner (Left mouse button)
[image: ]“Add Layer +” banner

Step C - Now using the free text search – search and find the layers described.  Add the selected layer(s) by clicking a left mouse button on the [image: ] located to the right of the desired layer.  
[image: Graphical user interface, application

Description automatically generated]Free text search

Step D - The added layer will now appear in the “Map Viewer window” and be displayed in the table of contents. When all layers have been added, it should look similar to the image below: 
 [image: Map

Description automatically generated]Layer displayed in
“Table of Contents”
Potato suitability map, property boundary and contours displayed in LISTmap

TIP: to view underlying soil and climate information within the Potato suitability map layer, click anywhere in the map viewer (information will be displayed in the “Identify Results” window): 
[image: Graphical user interface, application

Description automatically generated]



6. Now “toggle” between the added layers using the layer control tools [image: ] to either turn off, remove or change the drawing order of the layer. Also try toggling between Basemaps to view the aerial imagery and other useful Basemap layers: 
[image: Graphical user interface, application, chat or text message

Description automatically generated]
TIP: For each map layer you can view the individual properties by toggling the layer arrow [image: ]. Expanding this will provide access to the map symbology and transparency bar (allowing you to adjust the layer visibility via click and drag). There are also links to More information detailing high level information about the layer. Feel free to explore!



ADDING LAYER FEATURES TO MARK-UP (REFER TO LIVE DEMO FOR STEPS 7 to 14)
After our investigations I am now satisfied that the property I am interested in is a great purchase and have subsequently brought the property. One of the first things I wish to implement on my new farm are new paddock boundaries. Here I can use LISTmap to plan and measure some proposed fence lines. I plan to use some of the existing features on the farm, like vehicular tracks as natural boundaries.
Open a new session of LISTMap (https://maps.thelist.tas.gov.au/listmap)
7. In the search area (identified below) enter either of the known key identifiers of the parcel - Title reference 52933/1 or PID 7778595 and hit the ‘Enter” key to again locate the property.
[image: ]Search text box

8. From the “Layers” tab top right-hand corner - Add in the “Cadastral Parcels” and “Road Centrelines” layers. When the above layers have been added, it should look similar to the image below: 
[image: Map

Description automatically generated]


9. Using the slider bar down (pictured below) or the mouse wheel zoom into road features at the bottom of the farm just off Osmaston Road.  The screen should look like this.
[image: ]Zoom slider bar


10. We will now select the road feature highlighted above by clicking on the feature with a left mouse button.
[image: Graphical user interface

Description automatically generated]Select this feature



11. An “Identify Results” box appears.  See below.
[image: ]
12. From the “Identify search results – left mouse button click on the “Add this feature to markup tool”.
[image: ]“Add this Feature to Mark-up” tool

13. This copies the feature from the layer into a markup layer that can be either turned on or off by checking the tick in the table of contents.
[image: ]Toggle on/off to see or hide mark-ups


14. Now do the same for the additional road centerline features identified below.
[image: ]Select this feature
Select this feature


ADDING LINE FEATURES TO MARK-UP (REFER TO LIVE DEMO FOR STEPS 15 to 20)
15. Now from the “Tools” tab select the “Drawing Tools” drop down.  The following palette will appear.
[image: ]
16. Use the “Select features” tool  [image: ]and select the road centerline features that was previously added to the mark up layer.
17. A “Format Line” dialogue box appears. This shows the current line width, color, transparency, and length of the selected feature.  Change the road centerline features to a red to better represent the feature.
[image: ]
18. From the same “Drawing Tools” palette now select the select the “Add a line” tool. [image: ]
19. Now enter the green lines noted below, starting with a left mouse button click to commence the line and a double left mouse button click to finish.  
20. From the “Drawing Tools” palette select the “Select Features” tool [image: ] and identify the new lines.  A “Format line” dialogue box will appear - change the color of the freehand lines to green.  Your map should now look like the picture below:
[image: ]Green lines



ADDING TEXT FEATURES TO MARK-UP (REFER TO LIVE DEMO FOR STEPS 21 to 26)
21. With the Paddock boundaries now defined select from the “Drawing Tools” palette the “Add label” tool. [image: ]
22. Click roughly in the middle of each paddock and paddock names to each area (Paddock 1, 2, 3, 4).  Your map should look like the picture below.
[image: ]
23. We now also want to know and then add the areal size of the paddock as text labels to the map.  Select from the “Map Tools” palette and then the “Measure Area” tool. [image: ]Measure Area tool

24. Using this tool, hit left click to start, another left click to change direction and double left mouse button click to finish. Record the area value for Paddocks 1, 2,3 and 4.
25. Select from the “Drawing Tools” palette the “Add label” tool. [image: ]
26. Click roughly in the middle of each paddock and enter the paddock area value for Paddock 1,2, 3 and 4.  

TIP: to make edits for any text labels in your map - use the “Drawing Tools” palette and the “Select Features” [image: ]  tool. Click on the text in your map to correct spelling mistakes, text color, location or orientation.


Your map should now look similar to the image below:
[image: Map

Description automatically generated]
https://maps.thelist.tas.gov.au/listmap/app/list/map?bookmarkId=657236 


ADDING POLYGON FEATURES TO MARK-UP (REFER TO LIVE DEMO FOR STEPS 27 to 31)
As the farmer I am thinking about growing Potatoes on the property as a potential future enterprise crop. Therefore, we will add this layer to LISTmap (based on projected climate to 2030) and trace some potential planting areas. 

27. Add the Enterprise Suitability – Potatoes (CFT 2030 RCPs scenario 8.5) layer in your table of contents (See point 5 to add a layer).  When you add this layer to your map, it has a solid symbology and blanks out the base map. To rectify this, firstly click and drag this layer (by clicking and holding the layer icon [image: ]  located to the right of the layer name) from the top of the “Add Layer+” contents pane to the bottom.  Secondly, select the arrow to the left of the layer name to expand its contents: 

 [image: Text

Description automatically generated with medium confidence] Select this arrow [image: ]


The following information is now available:
 [image: Graphical user interface, text, application

Description automatically generated]Transparency slider bar
Layer legend

Move with the “Transparency” slider bar to the right until it reaches 60% transparency, and the background Topographic map (or aerial imagery) is viewable.  
28. Zoom to ‘Paddock 4” (Roll mouse wheel or use zoom bar) and note the area that is classified “Well suited” and “Well suited (with soil management)” to growing Potatoes.
TIP: to view underlying soil and climate information within the Potato suitability map layer, click anywhere in the map viewer (information will be displayed in the “Identify Results” window)
29. Select the “Add an Area” tool [image: ]from the Drawing Tools palette and trace around the shape of the “Well suited” and “Well suited (with soil management)” areas. Do this via mouse click by placing nodes around this zone to form a polygon shape. Double click to end.
30. From the Drawing Tools palette select the “Select Features” button [image: ] , click on the newly added polygon to see the “Format Area” table.  Change the color of the border line and fill color and adjust the transparency so it’s semi-transparent (refer to image below).  
31. Also, we will add the measured area of this polygon as extra text to the map. To do this, click on the [image: ] from the “Format Area” table (refer to image below):
 [image: Map

Description automatically generated]Click ‘+’ button to add polygon area value to map.
“Well suited” area for future potential potato production
Adjust polygon colors and transparency

https://maps.thelist.tas.gov.au/listmap/app/list/map?bookmarkId=657205 


ADDING SPATIAL DATA (REFER TO LIVE DEMO FOR STEPS 32 to 35)
An Agronomist has been on site and taken some soil samples to identify potential prime locations for future potato production. The Agronomist has sent you an Excel file (in CSV format) that show the locations of Ferrosol soil sites. We will add these into LISTmap to view their locations in our map.

32. Download the soil sites (Ferrosol Soil Sites.csv) from the link below:
https://nrmdatalibrary.dpipwe.tas.gov.au/FactSheets/WfW/Training/  
33. From the “Drawing Tools” palette (under the ‘Tools’) select the “Import spatial data” tool. [image: ]
The following dialogue box appears:
[image: ]
34. Select “Choose File” and navigate to the file location that was previously downloaded and select the file (Ferrosol Soil Sites.csv).
35. Now select the “Coordinate System” drop down and change it to “MGA Zone 55”
36. Now select “OK” – Point features should now appear on our map.  
[image: Map

Description automatically generated]
https://maps.thelist.tas.gov.au/listmap/app/list/map?bookmarkId=657220 
DETERMINING NEW PIVOT IRRIGATOR AREAS (REFER TO LIVE DEMO FOR STEPS 37 to 42)
As the farmer I would also like the paddocks to be irrigated and therefore would like to measure out potential areas for new pivot irrigators. We can measure the paddocks and determine best size and location of pivot centers to define the origin of the span length.
37. From the Map Tools palette select the “Measure lengths” button [image: ] and work out the radius length for paddock one. This will represent the span length of the pivot irrigator (should be roughly 295m).
38. From the Drawing Tools palette select the “Add a defined circle” button  [image: ].  Now left mouse button the centre of the paddock (or centre of your proposed pivot irrigator).  The following dialogue box appears.
[image: ]
39. Enter the following radius for paddock one – 295m.
40. Do the same for paddock 3 by following steps in 37 & 38 to approximate the span length of the pivot irrigator and create another pivot circle.
TIP: Select from the Drawing Tools palette the “Select Features” button [image: ] , to reposition the proposed pivot circle to be ‘snug’ within the paddock boundaries (if required).
TIP: LISTmap also has a duplicate feature [image: ] that can be used to duplicate text, lines, points and polygons. This can be used to duplicate the pivot circle in paddock 1, and to place the resulting duplicate circle in paddock 3. 

Your map should look similar to the image below:
[image: A picture containing chart

Description automatically generated]
https://maps.thelist.tas.gov.au/listmap/app/list/map?bookmarkId=657245 
41. Finally, toggle the “Basemap” tab (Top right hand corner) and change the “Basemaps” to the ESRI imagery to view any existing vegetation that may need to be cleared or to check to see if any of the pivot circles interfere with existing infrastructure.  Note Paddock 1 has a Dam and Paddocks 3 has built infrastructure (a shed close to the road frontage).  

42. Readjust the pivot circles by firstly deleting the current circles in your map and then remeasuring and producing new pivot circles so they avoid the dam in paddock 1 and shed in paddock 3 (by following steps in 37 & 38).
TIP: try using the ellipse tool [image: ] as an alternative way to draw the pivot circles. Simply click and drag your mouse over your map to form a circle whilst the tool is activated from within the Drawing Tools palette.

At the conclusion your map should now look similar to the picture below:
[image: Chart, map

Description automatically generated]
https://maps.thelist.tas.gov.au/listmap/app/list/map?bookmarkId=657259 



ADDING ADDITONAL MAP TEXT (REFER TO LIVE DEMO FOR STEPS 43 to 50)
43. From the “Layer” tab – top right-hand corner – now find and add into the table of contents the “Road Centrelines” if this is currently not viewable (See Step 5 to add a layer).
44. Left mouse click on the red road centreline feature that runs along the bottom of the property.
45. An “Identify Results” dialogue button (pictured below) appears.  Find the Road centerlines results and note the “Primary name” of the road – Osmaston Road.
[image: ]
46. From the “Drawing Tools” palette now select the “Add label” tool. [image: ]
47. Click in the map area, just off the road centreline, somewhere near the middle of the farm.
48.  A “Specify the Text” box appears – type ‘Osmaston Road’ into the text area.
[image: Graphical user interface, application

Description automatically generated]
49. Now select from the Drawing Tools palette the “Select Features” button [image: ] , to change the color and size.  Text color to red and text size to 75%.
50. Using the same “Select Feature” tool adjust the text so it runs parallel to the road.   Note: Look for the green semi-circle [image: ] in the lower left-hand corner to pivot text.
Your map should now look like the image below:
[image: ]
https://maps.thelist.tas.gov.au/listmap/app/list/map?bookmarkId=657278 


Once we’re happy with our map, we want to print or save this so we can return to it later - LISTmap has the capacity to print or save a bookmark for later use.
PRINTING:
Select the “Tools” tab top right-hand corner with a left mouse button.
[image: ]“Tools” tab

Now select from the drop-down menu the “Map Tools” option.  The following menu appears:
[image: ]
Select the print tool  [image: ] and complete the print options by providing “Map Title” and “Other map selections” to finalize your georeferenced PDF.  
[image: Graphical user interface, text, application

Description automatically generated]
Note: A georeferenced PDF can be added into a GPS, Orux or Avenza Maps as a background for future on farm in field capture. (e.g. Capturing farm irrigation pipelines using a GPS)

BOOKMARKS:
LISTmap has the ability to save “bookmarks” so you can save the map(s) you have created to update at a later date or share with others.
Step 1 – Click on the “Tools”tab and select the “Map Tools” option.  
Step 2 – From the “Map Tools” menu select the”create a sharable bookmark” tool [image: ] .  
Step 3 – Enter the name of the bookmark you wish to save.
[image: Graphical user interface, text, application

Description automatically generated]
This bookmark is now saved either to the hard drive of your computer, depending on whether you have logged into LIST.
NOTE: All bookmarks that are saved are private until shared with others via selected media options. 
To recall a bookmark:
Step 1 – Click on the “Tools”tab and select the “Map tools” option.  
Step 2 - From the “Map Tools” menu select the “open bookmarks” tool [image: ].
Step 3 - Either click on the name of the bookmark to recall the LISTmap session.  This will open the saved session in a new LISTmap window.  Alternatively, select one of the social media options to share with another person. (eg Agronomist or stock agent)
[image: Graphical user interface

Description automatically generated]Click on map name to recall LISTmap Session
Share with others via email or social media options




Thank you for your participation!


Further support:
https://www.thelist.tas.gov.au/app/content/the-list/news_and_information/resources/listmaphelp.pdf
Feel free to contact our helpful Client Services team by:
• Phone: (03) 6165 4444 or
• Email: listhelp@dpipwe.tas.gov.au


Training materials (web link):
https://nrmdatalibrary.dpipwe.tas.gov.au/FactSheets/WfW/Training/
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